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1  Introduction. The MIDG Display Utility is a Windows® executable program 

included on the MIDG Series INS/GPS software and utilities CD-ROM (Figure 1). 

This program is designed as a graphical user interface and enables the user to change 

the operational settings of the MIDG Series INS/GPS. The MIDG Display Utility 
has several functions such as; data recording, artificial horizon correction, sensor 

plotting and magnetometer calibration. 

 

2  MIDG Series INS/GPS Hardware Interface. The MIDG Series INS/GPS 

provides a RS-422 signal output. Refer to the MIDG Series INS/GPS user manual 

for instruction on how to properly interface the MIDG Series INS/GPS. 

 

 

3  The MIDG Display Utility. The MIDG Display Utility has two main screens. These screens are divided into several logical 

sections and each  logical section corresponds to a specific message outputted by the MIDG Series INS/GPS. Refer to the latest 

MIDG Series INS/GPS Message Specification for more information on the specifics for each message available.  

 

The MIDG Display Utility is divided into two (2) tabs consisting of the NAV/GPS screen and IMU/Time screen. Each screen has 

been divided into logical sections for each of the messages which may be provided by the MIDG Series INS/GPS. 

 

 

4.  NAV/GPS Screen. The NAV/GPS screen displays the GPS and navigational 

data from the MIDG Series INS/GPS. This data is comprised of several parts. Each 
part will be detailed starting from the top-left corner of the screen (Figure 2). 

 

 4.1 Menu Bar. The Menu Bar contains several options which enable 

  the user to interface and configure the MIDG Series INS/GPS. 

 

  A. Port - This drop-down menu is used to select the COM 

   port to which the MIDG Series INS/GPS is connected. 

 

  B. Baud - This drop-down menu is used to set the baud rate 

   for the MIDG Display Utility only. 

 

  C. Options - This drop-down menu opens the MIDG Config and Plot dialog boxes. 

 

  D. Help - This drop-down menu opens the information box about the MIDG Display utility and the contact 

   information for Microbotics, Inc. 
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 4.2 Record - The record button allows users to record data from the MIDG Series INS/GPS for later analysis. The 

  blue words, "no file" and the "0 kB" indicates that no file has been selected and no data is being recorded. Please 

  refer to Section 8 of this manual for more information on this feature. 

 

 4.3 Status - The Status section displays the current status of the MIDG Series 

  INS/GPS including; Run Mode, Temperature, Non-Volatile Fram  

  Configuration (NV Config) status, and the current Time Stamp (Figure 3). 

  The message ID for the Status message is "1." Each piece of information 

  is detailed below. 

 

  A. Run mode - The run mode display the current state of the unit. 
   Please refer to the application note titled, "AN001 Operational Modes" included in the documents folder 

   for complete details on the operational modes of the MIDG Series INS/GPS. 

 

  B. Temperature - This displays the current internal temperature, listed in degrees Celsius, of the unit. 

 

  C. NV config valid - This displays the current status of the unit's non-volatile ram (NV Config). 

 

 4.4 Nav Sensor - The Nav Sensor section displays the individual data outputs, 

  as determined by the Kalman filter, for each of the rate (p, q, r) and  

  accelerometer (ax, ay, az) sensors as well as the yaw, pitch, and roll  

  sensed by the MIDG Series INS/GPS (Figure 4). The message ID for the 
  Nav Sensor message is "10." Each piece of information is detailed below. 

 

  A. p, q, r - Theses sensors correspond to the x, y, and z axis rate  

   sensors. 

 

  B. ax, ay, az - These sensors correspond to the displays the ax, ay, and az accelerometer sensors  

   (-1000 on the z axis is equivalent to one (1) G of gravity). 

 

  C. Yaw, Pitch, Roll - This output is the yaw, pitch, and roll in degrees as sensed and calculated by the unit. 

 

 4.5 Nav PV - The NAV PV section displays the navigation position and velocity  

  as determined by the MIDG Series INS/GPS. This is the Kalman filtered output  
  which is derived from a combination of sensor readings and GPS information  

  (Figure 5). The message ID for the Nav PV message is "12." Each piece of  

  information is detailed below. 

 

  A. X,Y, Z - This displays the location of the unit in the specified format. 

 

  B. Velocity - This displays the velocities sensed by the unit in the specified velocity format. 

 

  C. Type - This display the Run Mode of the unit. 

 

 

 4.6 Nav Hdg - The NAV Hdg section displays several pieces of heading information as determined by the Kalman 

  filter and the magnetic declination and calibration of the MIDG Series INS/GPS. (Figure 6). The message ID for 

  the Nav Hdg message is "13." Each piece of information is detailed below. 

 
  A. Mag Dec - The "Mag Dec" is the magnetic declination. The declination 

   is positive when the magnetic north is east of true north and negative  

   when magnetic north is west of true north. 

 

  B. Mag Dip - The "Mag Dip" is the magnetic inclination. A Positive "dip" 

   value indicate the field is pointing into the Earth and negative values  

   indicate the field is pointing out of the Earth.  
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  C. M Hdg - The "M Hdg" is the magnetic heading is the heading detected and calculated by the internal 

   magnetometer and Kalman filter. A positive reading indicates a heading with an Eastern influence and a 

   negative reading indicates a heading with a western influence. 

 

  D. COG - The "COG" is the course over ground as calculated by the Kalman filter. 

 

  E. SOG - The "SOG" is the speed over ground and determined by the Kalman filter. 

 

  F. Vup -  The "Vup" is the calculated vertical velocity as determined by the Kalman filter. 

 

 4.7 NAV ACC - This message indicates the accuracies of the error  
  estimates in accordance to the Kalman filter covariance's (Figure 7). 

 

  A. H - Indicates heading in position (Pos), velocity (Vel) and  

   attitude (Att). 

 

  B. V - Indicates velocity in position (Pos), velocity (Vel) and  

   attitude (Alt). 

 

 4.8 Artificial Horizon - The artificial horizon provides a visual display of the Yaw,  

  Pitch, and Roll as sensed and calculated by the unit (Figure 8). 

 
  A. Yaw - Displayed in increments of five (5) degrees with notations every  

   ten (10) degrees and numerical notations every thirty (30) degrees. 

 

  B. Pitch - Displayed in increments of five (5) degrees with numerical  

   notations every ten (10) degrees. 

 

  C. Roll - Displayed in increments of five (5) degrees with notations every  

   fifteen (15) degrees. 

 

 4.9 GPS PV - The GPS_PV is the position and velocity as reported from the GPS receiver (Figure 9). The message ID 

  for the GPS_PV message is "20." Each piece of information is detailed below. 

 
  A. X, Y, Z - This represents the three dimensional (3D) coordinate axis position of the unit on the earth and 

   is will be displayed as; ECEF (Earth Centered, Earth Fixed) or LLA (Latitude, Longitude, Altitude). 

 

  B. Ve, Vn, Vu -  This represents the three dimensional (3D) position  

   velocities of the MIDG Series INS/GPS on the earth and is will be  

   displayed as; ECEF (Earth Centered, Earth Fixed) or ENU (East/ North 

   Up). 

 

  C. Type - This field defines the type of GPS fix, the Kalman filter requires 

   a minimum of a 3D Fix. There are only two (2) "fixes" which will be  

   displayed in this field. 
 

   i. No Fix - GPS information is not available or is invalid for position fix. 

   ii. 3D Fix - GPS information is available and is valid for a position fix. 

 

  D. Diff - This indicates whether the GPS receiver is using differential satellites. 

 

  E. SVs - This is the number of satellites which are currently tracked by the GPS receiver. 

 

  F. FixOK - Indicates the GPS receiver has a valid position fix. 

 

  G. TOWV - This is a seconds-into-week number value outputted by the GPS receiver. 

 
  H. WNV - The week number value outputted by the GPS receiver. 
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 4.10 GPS_SVI - The GPS_SVI (Figure 10) displays the currently tracked GPS satellites (SVs). The rows are numbered 

  1-16 for the number of possible SVs which can be tracked by the GPS receiver. Each column represents data 

  pertaining to each of the tracked satellites. The message ID for the GPS_SVI message is "21." Each piece of 

  information is detailed below. 

 

  A. ID - This is the satellite identification number broadcasted by the satellite. 

 

  B. CN - This is the carrier signal to noise ratio (CN/o). Normal readings range 

   from 38 to 55. 

 

  C. F - Flags indicated the status of the information being received from the 
   tracked satellites. There are five (5) possible flags which may be set; 

 

   i. DGPS data available for this satellite. 

   ii. Orbit information available for this satellite. 

   iii. Orbit information is ephemeris. 

   iv. Satellite is unhealthy, will not be used. 

 

  D. QI - This is the information regarding the receiver channel. There are  

   six (6) possible values. 

 

   i. 0: Channel is idle. 
   ii. 1-2: Channel is searching for GPS Signal. 

   iii. 3: Signal is detected but is unusable. 

   iv. 4: Code is locked. 

   v. 5-6: Code and carrier locked. 

   vi. 7: Code/carrier locked and receiving 50 bps of data. 

 

5  IMU/TIME Screen. The IMU/Time screen is the second main screen of the MIDG Display Utility (Figure 11) and like the 

NAV/GPS screen, it too has been divided into several logical sections which display various information outputted by the MIDG 

Series INS/GPS. 

 

 5.1 IMU/Time Logical Sections. Each logical section of the  

  IMU/Time tab provides IMU and timing information transmitted 
  from the MIDG Series INS/GPS. This section of the manual will 

  detail each of the logical sections for the IMU/Time tab and will 

  specify the corresponding  message ID. Please refer to the MIDG 

  Series INS/GPS Message Specification for complete information 

  on all of the available MIDG Series INS/GPS messages. 

 

 5.2 IMU Data - The IMU_Data section displays the internal IMU  

  sensor outputs prior to any Kalman filtering. This block displays 

  the angular positions of the unit (Figure 12). The message ID for 

  the IMU_DATA message is "2." Each piece of information is detailed below. 

 
  A. p, q, r - These outputs correspond to the angular rates of 

   the unit rate sensors (x, y, and z, respectively). 

 

  B ax, ay, az - These outputs correspond to the angular  

   accelerations of the unit's  accelerometers. 

 

  C. mx, my, mz - These outputs correspond to the angular 

   magnet reference of the unit's magnetometers. 
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 5.3 IMU Mag - The IMU Mag section displays the three axis of the 

  magnetometer. This is the same data displayed in the IMU Data 

  section (Figure 13). The message ID for the IMU_MAG message is 

  "3." 

 

 5.4 GPS_CLK - This section displays the GPS clock solution (Figure 

  14). The message ID for the GPS_CLK message is "23." Each piece of 

  information is detailed below. 

 

  A. Clock Bias (ns) - This displays the difference between the 
   GPS clock and Coordinate Universal Time (UTC). 

 

  B. Clock Drift (ns/s) - This is a display of the clock drift of the 

   GPS receiver in comparison to the received UTC. 

 

  C. Time Accuracy (ns) - Time accuracy estimation. 

 

  D. Frequency Accuracy (ps/s) - Frequency accuracy estimation. 

 

 5.5 TIM_UTC - This section displays the (UTC) when a valid data is  

  available from the GPS receiver (Figure 15). The message ID for the  
  TIM_UTC message is "25." Each piece of information is detailed below. 

 

  A. UTC - This is the UTC time which has been deciphered into a  

   Year-Month-Day and GMT format. 

 

 5.6 TIM ERR - This message is a legacy message and does not provide any usable data. This message has been 

  disabled in firmware version 2.3.1 and higher. 

 

 5.7 TIM PPS - This message is a legacy message and does not provide any usable data. This message has been 

  disabled in firmware version 2.3.1 and higher. 

 

 5.8 TIM TM - The TIM_TM message is available on MIDG Series  
  INS/GPS units with the Time Mark option (MBI#SIS90031C-SR) The  

  unit sends out a standard high pulse and an inverted pulse for a duration 

  of 1 second (Figure 16). The message ID for the TIM_TM message is  

  "28." 

 

  A. GPS Time (ms) - This time is the GPS time from the beginning of the pulse. 
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6  MIDG Display Utility Configuration Menu. The MIDG Display Utility has a link to open 

the MIDG Configuration dialog box (MIDG Config). The MIDG Config dialog box allows the 

user to fine tune the MIDG Series INS/GPS output to their specific application requirements. 

 

 6.1 Accessing the MIDG Config dialog box. The MIDG Config dialog box 

  (Figure 18) can only accessed through the MIDG Display Utility. The  

  following will instruct the user on how to access this feature. 
 

  1. Start an instance of the MIDG Display Utility. 

 

  2. Select the "Options" drop down menu. 

 

  3. Select "MIDG Config". 

 

 
 
 6.2 General - The "General" tab (Figure 18) has three (3) function buttons. These buttons allow the user to control the 

  configuration profile. Each feature is detailed below. 

 

  A. Save Configuration - This function allows the user to save any changes made to the configuration profile 

   of the unit. The configuration profile is stored in the NV Ram 

 

  B. Revert to Saved Configuration - This function allows the user to 

   discard any changes to the Configuration which have been set but not 

   saved. 

 

  C. Erase Configuration - This function allows the user to load the 
   factory default settings for the unit (Attachment A). 

 6.3 Protocol - The "Protocol" tab (Figure 19)is completely grayed out. Though 

  there are three (3) radio buttons, there are no settings which can be changed 

  here. The "Microbotics Binary" is the only protocol currently supported by 

  Microbotics, Inc. 

 

 6.4 Baud -  The "Baud" tab (Figure 20) is used to set the communication transfer 

  rate. This rate can be adjusted as needed for wireless communication or 

  lengthy communication cables. The MIDG Display Utility defaults to 115200 

  baud.  

 

 

 6.5 Messages - The "Messages" tab (Figure 21) is used to set the message rates for 

  all of the different sections of the NAV/GPS and the IMU/Time screens. This 

  tab allows users to change which messages and message rates are outputted by 

  the unit. 
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  A. Message Drop-down List - This drop-down list will display all of the messaged which may be  

   configured. Table 1 shows all of the displayed messages for this tab. 

 

 

  B. Divisor Entry Box - The Divisor entry box allows any 

   selected message to be configures to be outputted at a 

   specific frequency from one to fifty (1-50 Hz).  

   Messages may be disabled from the output stream by  

   entering a zero (0) as a divisor; however, all messages 

   can still be queried through a control platform when  

   they are disabled. 

 

  C. Frequency Display - The frequency display calculates 

   the divisor automatically and displays the frequency of 
   the message.  

 

 
 6.6 Run Mode - The "Run Mode" tab (Figure 22) is used to change 

  the operating mode and configuration of the unit. 

 

  A. IMU - The "IMU" mode converts the unit from an INS 

   into an inertial measurement unit (IMU) and represents 

   the most basic operation. The IMU can only provide calibrated values for angular rate, acceleration, and 

   magnetic field.  

 

  

 

  B. Vertical Gyro - The "Vertical Gyro" (VG) mode, basic attitude 

   estimations are added to the IMU data. In VG mode, the data from 

   rate sensors is accumulated to provide an estimate of attitude.  
   Accelerometer data is added to compensate for rate sensor drift and 

   magnetometer data is used to indicate magnetic north. 

 

  C. INS - The "INS" mode provides estimates of position, velocity, and 

   attitude at up to 50Hz using a state estimation filter. Error-corrected 

   angular rates and accelerations are provided as well. In order to enter 

   INS mode, the MIDG II INS must be configured for INS operation 

   (which is the default) and GPS must be available. 
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 6.7 Format - The "Format" tab (Figure 23) is used to configure the output of the unit's position and velocity messages 

  displayed on the NAV/GPS screen. 

 

  A. Position Format - Position Format allows the user to select the 

   position format to be outputted in the GPS_PV and   

   NAV_PV messages. 

 

   i. ECEF - "Earth-Centered, Earth-Fixed." A coordinate 

    system where X, Y, and Z coordinates are in relation to the 

    center of the earth (Center of Earth is point 0,0,0). 
 

   ii. ENU - "East, North, Up" A coordinate system formed from 

    a plane tangent to the Earth's surface fixed to a specific 

    point on the Earth's surface. By convention the east axis is 

    labeled x, the north y and the up z. 

 

   iii. LLA - "Latitude, Longitude, Altitude" and is a geographic coordinate system which enables 

    every location on the Earth to be specified by a set of numbers. 

 

  B. Velocity Format -  The velocity format adjusts and determines how velocity output is formatted in the 

   GPS_PV and NAV_PV messages. 
 

   i. ECEF - "Earth-Centered, Earth-Fixed." A coordinate system where X, Y, and Z coordinates are 

    in relation to the center of the earth (Center of Earth is point 0,0,0). 

 

   ii. ENU - "East, North, Up" A coordinate system formed from a 

    plane tangent to the Earth's surface fixed to a specific point 

    on the Earth's surface. By convention the east axis is labeled 

    x, the north y and the up z. 

 

  C. ENU Relative To First Fix - This checkbox is grayed out by default. 

   However, if the position format of ENU is selected, the checkbox 

   becomes active. This check box is used to set a "Home" location 
   when a GPS lock is achieved. The MIDG II INS then calculates its 

   location from this point of first GPS fix. 

 

 6.8 Pos Ref - The "Pos Ref" tab is used to set a location other than the first fix is 

  needed to calculate a "Home" location for the unit (Figure 24). This tab may be 

  manually populated or allowed to be populated by the GPS unit.  

 

 6.9 XForm - The "XForm" tab (short for "Transform") is used to change the virtual position of the unit (Figure 25). 

  When a MIDG Series INS/GPS is mounted in an application; perfect alignment is often not possible. The  

  "XForm" tab aligns the unit's output from its own sensor coordinates into the coordinate frame of the host vehicle. 

  The angles are yaw-pitch-roll Euler combination. These angles are required to rotate the MIDG Series INS/GPS 
  frame to be coincident with the application. 
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 6.10 Heading - The "Heading" tab is used to adjust the magnetic declination offsets 

  of the internal magnetometer which reflect the current direction of magnetic 

  north when the unit is in the presence of magnetic interference (Figure 26). 

  Under normal operating conditions, magnetic declination is calculated and 

  applied via self-contained tables (International Geomagnetic World Model) 

  based on the current Latitude and Longitude determined by the GPS receiver. 

 

  A. Bias Values -  The bias values adjusts the units magnetic declination 

   and magnetic dip. 

 
  B. Enable in INS mode - This checkbox is used to enable or disable the 

   magnetometers in INS mode. 

 

  C. Enable in VG mode - This checkbox is used to enable or disable the magnetometers in VG mode. 

 

  D. Use Velocity vector for Heading Measurements - This checkbox is used to enable or disable the use of 

   velocity vectors for heading measurements. 

 

   i. Even When Turning - Maintains use of the velocity vectors for heading while the unit is 

    turning. 

 
  E. Aid Threshold - This sets the magnetometer aiding level. These levels are detailed fully in application 

   note "AN001 Operational Modes." 

 

 

 

 6.11 Accel - The "Accel" tab is used to compensate for accelerometer biases (Figure 

  27). The accelerometer biases compensation aids the unit by removing any 

  biases which may be present. These biases are native to the sensors themselves 

  and should be compensated for to ensure a more precise solution. 

 

 

 
  A. Accelerometer Bias Compensation Formula. Figure 28 displays a 

   generic formula for calculating accelerometer bias compensation. The 

   formula example is to calculate the "y" accelerometer bias; however it 

   is the same formula for all three axis. 

 

 6.12 Info - The "Info" tab contains the indentifying information specific to the 

  MIDG Series INS/GPS. This tab contains several pieces of information and 

  may be queried at any time. The information displayed is: the manufacturer; 

  product name; product part number; product serial number; the stock keeping 

  unit number (SKU); and the firmware version (Figure 29). 
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7  Plotter. The "Plotter" is a sub utility found under 

the "Options" drop-down menu of the MIDG Display 

Utility. The "Plotter" displays the real time outputs of 

the sensors from the unit. The Plotter can also display 

the navigational rates and navigational accelerations as 

determined by the Kalman filter (Figure 30). All of the 

information displayed in the Plotter follows the same 

color assignment per axis, regardless of which sensor 

information is selected for display.  

 
 A. Red - "x" axis, 

 

 B Green - "y" axis 

 

 C. Blue - "z" axis. 

 

 

 7.1 Plotter Sections. The "Plotter" utility is comprised of several different functions which are useful to the user. Each 

  of these functions are detailed below. 

 

 7.2 Mode - The "Mode" section of the "Plotter" utility contains five (5) radio button which allow the user to visually 

  compare all three axis of any given sensor. 

 

  A. Rate - This radio button allows the user to view the calibrated rate sensor outputs (p, q, r) in real time. 

 
  B. Accel - This radio button allows the user to view the calibrated accelerometer sensor outputs (ax, ay, az) 

   in real time. 

 

  C. Mag - This radio button allows the user to view the calibrated magnetometer sensor outputs (mx, my, mz) 

   in real time. 

 

  D. NAV Rate - This radio button allows the user to view the navigation rate sensor outputs post Kalman 

   filtering. 

 

  E. NAV Accel - This radio button allows the user to view the navigation accelerometer sensor outputs post 

   Kalman filtering. 
 

 7.3 Center - The "Center" button re-centers the display so that all axis for any given sensor system can be displayed 

  simultaneously. 

 

 7.4 Pause - The "Pause" checkbox allows the user to pause the real time display. Pausing the real time display will not 

  save any data. When resuming the real time output the Plot utility will start displaying the current sensor data. 

 

 7.5 Grid - The "Grid" drop-down list box allows the user to superimpose grid lines over the real time sensor outputs. 

  The user can choose the following: none; horizontal; vertical; or both. 

 

 7.6 Mag Cal Utility - This "Mag Cal Utility" button is used only when performing a magnetic declination calibration. 

  Please refer to the instruction titled "MIDG Series INS/GPS Magnetic Declination Calibration Instructions" for 
  more information. 
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8  Recording Data. On the Nav/GPS screen, located under the menu bar is the 

"Record" button. The "Record" button allows the user the ability to record data for 

later analysis. The following will instruct on how to record the data output from the 

MIDG Series INS/GPS (Figure 31). 

 

 

 1. Connect the MIDG Series INS/GPS. Refer to the MIDG Series 

  INS/GPS User Manual for proper interfacing instructions. 

 

 2. Start an instance of MIDG Display Utility. 

 

 3. Select "Options" drop-down menu and select the "MIDG  

  Config" option to open the "Config" dialog box. 

 

 4. Select the "Messages" tab and set all desired messages and message rates  

 

 

 5. Press the "Record" button. This will open the "Save" dialog box. 

 

 6. Designate the location and name of the data file to be saved. 

 
 7. Press the "Save" button. This will close the "Save" dialog box and will start the recording of data. 

 

When finished recording, Press the "Stop" button a dialog box will appear verifying that the user is ending the recording and Press 

the "Ok" button and the recording is finished. Refer to the instruction titled "Parser Instructions" for information on parsing and 

editing the data. 

 

9  Help and Support. Microbotics, Inc. is dedicated to supporting the missions of our clients and offers free thirty (30) days of 

support for all of our products. The MIDG Display Utility, in the "Help" drop-down menu, contains the contact information for 

Microbotics, Inc.  

 

 1. Start an instance of the MIDG Display Utility.  

 
 2. Select the "Help" drop-down menu. 

 

 3. Select "About" option. The "About MIDG II Display" dialog box will 

  appear. 

 

Contact Microbotics, Inc. for pricing and availability. Specific technical questions should be sent to support@microboticsinc.com 

 

mailto:Support@microboticsinc.com
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ATTACHMENT A 

 

Default Settings for the MIDG Series INS/GPS. The following table are all of the default settings for the MIDG Series INS/GPS. 

Detailed information on all messages is available in the current MIDG Message Specification. 

 

 

Default settings for the MIDG Series INS/GPS 
TAB Setting Message Divisor Frequency (Hz) 

General N/A N/A N/A N/A 

Protocol Microbotics Binary N/A N/A N/A 

Baud 115200 N/A  N/A N/A 

Messages Enabled STATUS 50 1.00 

 Disabled IMU_DATA 0 0 

 Disabled IMU_MAG 0 0 

 Enabled NAV_SENSOR 1 50 

 Enabled NAV_PV 5 10 

 Disabled NAV_HEADING 0 0 

 Enabled NAV_ACC 50 1 

 Enabled GPS_PV 12 4.17 

 Enabled GPS_SVI 50 1 

 Disabled GPS_RAW 0 0 

 Disabled GPS_CLK 0 0 

 Disabled TIM_UTC 0 0 

Not Supported TIM_ERR N/A N/A 

Not Supported TIM_PPS N/A N/A 

Run Mode INS N/A N/A N/A 

Info N/A N/A N/A N/A 

Heading X=0. Y=0. Z=0 / Enabled in INS Mode N/A N/A 

XForm Yaw=0. Pitch=0, Roll=0 N/A N/A 

Pos Ref Relative to first fix -location dependant N/A N/A 

Format Position Format Velocity Format N/A N/A 

 ECEF ENU N/A N/A 

 

 


